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Altered Self Images

Since I’m a huge New England sports fan, I chose three photos of teams’ venues at which they play in. From 
there, I made each photo the same size in pixels per inch, and I also tampered with the various Photoshop 
effects such as contrast, brightness, hue, color saturation, photo filters, etc. to make each photo appealing/
intriguing to me. After I was pleased with the photo altering, I copied and pasted each photo onto one page. 
Next, I made a series of adjustments, including some photo transformations, canvas size modifications and 
providing equal negative space in between the photos as well as around the frame itself. As I finished up the 
editing process, I made two final edits, which were changing the canvas’ background color and putting some 
drop shadow effects on each photo (which I was really fascinated with).

In this assignment, I decided to use one of my favorite 
professional athletes, Red Sox baseball player David Or-
tiz, and add various supportive imagery. To start, I made 
a new file 12 by 12 inches, 150 megapixels in the RGB 
color mode. Then, the images I used include a farm-
like background, a beach sand foreground, the Boston 
Red Sox logo, the Entering Boston sign, a baseball 
umpire, a baseball, a baseball glove and two baseball 
bats in the shape of an ‘X’. For each image, I used the 
Photoshop tool called “selection tool” and well as the 
“magic wand” to properly obtain a crisp picture. Then 
after viewing each in the “select and mask” feature and 
making slight edits to the feathering and the edges, I 
copied and pasted each image into my final destination 
file. Once I transformed each photo’s size to my liking, I 
re-arranged the orientation/layout of the whole compo-
sition in a visual manner that made sense to me. Specif-
ically, for the baseball image, I used an effect that looks 
like it’s in motion or being thrown by a player. Lastly, I 
added text to the top of the composition (David Ortiz) 
and used an appropriate color and effect to make it 
stand out to the viewer.

This piece is very similar to my first work selections 
with Photoshop, with the exception that I used differ-
ent images and a different background photo. This 
time I used a hockey theme pertaining to my favorite 
hockey team to watch: the Boston Bruins. The pic-
tures I used include, player Patrice Bergeron, a hockey 
official, the entering Boston sign, hockey pucks, TD 
Garden, and hockey sticks. After using the selection 
tool to crop each photo, I transformed each photo to 
an appropriate size that made sense within the com-
position. The TD Garden background is logical in the 
sense that it’s the venue at which the Boston Bruins 
play their games. The sand foreground also indicates 
a popular beach many Bruin players attend during the 
offseason.

Independent Selections
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Independent Layer Mask

In this piece, I decided to use four different backgrounds to correspond with four 
different selections using layer masks in Photoshop. From top to bottom, the four 
images I used include: a body of water, a mountain setting, a desert, and a starry 
background within the desert. Each four selections is placed appropriately within 
a background setting; the seashell is located near the body of water, the coyote 
and deer are in the mountains, and the funky-looking camel is on the desert. 
After obtaining each background image, I made sure to select and mask each so 
that I could edit the piece non-destructively as layer masks. Once I collectively 
inserted all the pictures into the destination file, the layer masks aspect allowed 
me to use a feathered paint brush and paint the composition to my liking, while 
taking the selection placements into consideration as well.

Photo Retouching

In my first retouch piece (1), I took the mountain climber photo and changed the back-
ground color to black/white. I then used the spot healing brush tool and the healing 
brush tool to make the mountain surface look clean and normal without any unneces-
sary, abstract marks. Also, I took some selections, including the superhero Spiderman, 
the Marvel logo (movie company) and the Spiderman logo to resemble the mountain 
climber in the original photo. I then added a background photo of New York City and 
used the gradient tool to add the effect that Spider Man and the mountain climber are 
crawling away from the deteriorating skyscrapers. My use of the background eraser tool 
created the effect that the city is falling apart (similar to the impact of an earthquake at 
this location).

In my second retouch piece (2), I first used the healing brush tool to omit the sand on the shore in 
addition to the water waves and the boat in the upper right hand portion of the original photo. Next, I 
used the clone stamp tool to create the effect that there’s a replicated boat with the same people be-
low the original boat in the water. Finally, as I always like to do with my work, I added selections in the 
water, including a fish, shark, a couple jet skiing and a group of people rafting. I lastly used the opacity 
tool to make the fish appear as if it’s hiding below the water’s surface.
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Final Photoshop Poster 

In my final Photoshop poster project, I decided to 
advertise a Quinnipiac-Marist basketball game with 
the overall theme/message being that all ticket 
proceeds will go towards the Connecticut Breast 
Care Awareness Foundation. In celebration of 
October (breast care awareness month), I’m trying 
to convince and encourage not just the Quinnipiac 
community and sports fans, but other people in the 
Hamden CT area to purchase tickets in efforts to 
raise funds for a positive cause. I’m attempting to 
make them socially aware of the fact that it’s Octo-
ber and breast care awareness month through an 
athletic event, with the goal that average ticket in-
come will increase due to the breast care awareness 
aspect being featured.

In the actual piece itself, I included a pink/white 
stripped background to make the breast care aware-
ness component emphasized (the focal point). Then, 
I added selections of both team’s logos (Quinnipiac 
and Marist) and an ‘vs.’ symbol near the top of the 
poster to display the matchup. Next, I used se-
lections of two pink bows symbolizing breast care 
awareness, along with the drop shadow effect to 
make it visually clear, considering it may blend in 
with the pink/white background. I also added one 
player from Quinnipiac and Marist to make the sport 
(basketball) more evident. The selections of the 
MAAC logo and the ESPN logo are to tell non-goers 
what conference is associated with this game, and 
where it can be viewed on television. Lastly, I cre-
ated three separate text boxes which include: vital 
information about the game, where the proceeds of 
ticket money will be donated, and where people can 
go online to donate money for the CT Breast Care 
Awareness Foundation.

Illustrator Works
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Pencil Illustration

In my Adobe Illustrator pencil assignment, I used the rectangle tool to create most 
of the overall shapes of the pencil. To make these shapes, I used the appropriate 
dimensions, including a 36 x 36 pt. eraser, three 46 x 10 pt. eraser supporters, a 
36 x 360 pt. pencil base, and two 18 x 360 pt. pencil curves. After creating most of 
the pencil’s shapes, I then used the selection tool to grab the eraser’s corners and 
rounded them out to make it visually look like a realistic pencil eraser. Afterwards, 
I made two extra copies of the eraser supporter (mini rectangles) and then stacked 
them on top of each other, with the rounded out square (eraser) on the complete 
top. Next, I aligned the two pencil curves on each side of the writing utensil’s body. 
I then proceeded by creating a pencil point consisting of three additional shapes 
using the rectangle tool, which include: a 36 x 36 pt. square, a 36 x 42 pt. rectan-
gle, and a 30 x 42 pt. circle. Using the object > path > average navigation, I made 
the pencil point part connect to the bottom of the pencil’s base. I then pulled up 
my pathfinder and under shape modes I selected ‘unite’ so that the bottom two 
pencil points combine together to create one sharp edge/point. Afterwards, I took 
the circle piece I made with the ellipse tool and attached that to the bottom of the 
point. Then, I used my pathfinder to select the divide option, allowing me to make 
the point and circle overlap together as if it’s one whole piece. Lastly, I used five 
different colors to fill in the pencil. I filled the eraser portion with a light pink, the 
eraser supporters with a light gray/silver, the pencil’s base with a light yellow, the 
majority of the point with a traditional brown/tan, and the tip of the writing utensil 
in black.

Online Tutorial Star

In my Adobe Illustrator tutorial piece, I chose to make a star featuring “vector half-
tone effects,” according to the tutorial’s author, Chris McVeigh. I began by making 
a new file with pixel dimensions of 1800 x 1800. I then selected Effect > Document 
Raster Effects Settings. Then to finish this step, I entered 288 ppi (pixels per inch) 
under resolution. After I used the star tool to form a star occupying the majority of the 
page, I made another smaller one within the larger one. As I completed this, I navigat-
ed through the following: File > copy,  file > paste object > transform > scale. These 
steps permitted me to insert a smaller star 25% of the larger star’s size. Next, I was 
instructed to fill in the smaller star with a dark gray color with specific numeric values 
on the color scale (R = 77, G = 77, B = 77). I then made the larger star a white color 
with the numeric values of all R, G, and B at 255. Following that, I chose Select > Se-
lect All, then Object > Blend > Make. The next step in this process was to navigate to 
effect > pixelate > color halftone, at which point I was requested to fill in five different 
values. One of these five values consisted of the maximum radius (96), and the other 
four were channels controlling the screen angles, all of which were instructed to be 
128. This course of action inserted countless black dots within the stars themselves in 
a uniform fashion, which I thought was really unique of this program. Likewise with my 
pencil piece, I concluded this tutorial item by filling the inside of the bigger star with a 
green color. In other words, this green color is also surrounding the smaller inside star.
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Color-filled Boxes

In this color filled boxes assignment, I used various shapes of different quantities, sizes, 
angles and orientations to make a colorful, creative composition containing 49 one-inch 
boxes. I first started by making seven rows of seven boxes with each row consisting of 
equal negative space. Then, I used the shape tools to make each individual box unique as 
if each one was a mini canvas, including the rectangle tool, ellipse tool, polygon tool, star 
tool and the rounded rectangle tool. To my interest, I also inserted six different patterns 
on six boxes in the second row. However, the purpose/goal of this piece is exemplified 
with the countless shape colors showing various shades too throughout the file. Lastly, I 
made three duplicates of this design, and combined them into one square-shaped com-
position to create an intriguing visual appearance.

Pear

In this assignment. I used professor Grace’s document guide 
on drawing a pear while using the pen tool to trace the 
pear body and the leaf. After completing that process, I 
combined the leaf with the pear itself and placed it on top. 
Lastly, I used my color palet to add a light green color to the 
pear and more of a dark green to the leaf.
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Four Box Logos

NEW 
          HAMPSHIRE

“Live Free or Die”

In this assignment, I created four different logos within four 4-inch boxes in Adobe 
Illustrator using the pen tool. The first one is the Patriots logo with the word “Patri-
ots” shown across and the actual Patriots head appearing below. The second one is a 
light pink breast care awareness bow, which I’ll most likely use in my final quantitative 
illustration design. My third logo design entails a green body shape of my hometown 
state, New Hampshire. Moreover, I went above and beyond by not just designing this 
logo, but also adding selections (Photoshop concept) of New Hampshire’s state flag 
along with a New Hampshire moose license plate. Lastly, I designed an NFL (National 
Football League) logo with a dark blue background around the shield. As previously 
stated, all of these logo designs were created with the pen tool. Further, the color 
palette in CMYK mode with all the options listed allowed me to insert all the various 
colors in every composition.

Final Illustrator Poster 

Signs/Symptoms:

Prevention Tips:

          One in eight women are diagnosed 
                with breast cancer in their life.

Breast cancer is the most common 
cancer in the world among women.

 There are more than 2.9 million
  survivors in the United States.

 A breast cancer diagnosis
is made every two minutes. 

   Every 15 minutes, a woman in the
United States dies from breast cancer.

Change in size/shape of breast

Lump or thickness of breast

Breast skin is scaly, red or swollen  

Nipple becomes tender

Exercise regularly

Consume less alcohol

Avoid smoking

12
3

6
9 R.I.P.

In Memory of
Jennifer Smith

2.9 million 2.9 million

Breast Cancer Awareness
The Facts:

In my Adobe Illustrator final poster design, I de-
cided to portray a data-driven poster that spreads 
information and awareness regarding breast can-
cer because this is what my final Photoshop poster 
design also entailed. As far as my information, I 
wanted to include important content, so I thought 
displaying some statistics/facts, signs/symptoms, 
and prevention tips would cover the major facets 
of what I want my audience to be educated on. 
Specifically concerning the facts, I inserted text 
about the cancer diagnosis, how many women are 
victims, and how often women obtain the disease. 
I researched some signs/symptoms and preven-
tion tips from credible sources and other relatable 
infographics, and listed what I felt were the most 
important ones.

Meanwhile, my design process started with an 
organization method choice, which was having 
the text on the left, and the images/visuals on the 
right. For each piece of information, I used a white 
breast care awareness bow to symbolize a bullet, 
or the beginning of a new note. In addition, using 
the pen, ellipse, and rounded rectangle tool, I 
drew appropriate images for each blurb of infor-
mation. On occasion, I replicated some of those 
images as well. For example, the first fact states, 
“One in eight women are diagnosed with breast 
cancer in their life.” As a result, I decided to dis-
play eight stick figures and make all of them black 
with the exception of one, which is white, repre-
senting the message’s visual meaning. Lastly, I ref-
erenced my personal logo I also made in Illustrator 
when I copied my pink breast care awareness bow 
onto the top left hand corner of the poster. With 
this, I attempted to created an effect that shows 
the pink bow as the focal point, yet have the left 
portion of it partially cut off. In essence, I imple-
mented professor Grace’s suggestions/feedback 
to my advantage prior to submitting this final 
composition.
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InDesign Works

12. Single-page Poster

13. Single-page Turtle

Single-page Poster

In this InDesign composition, I created a single-page design that features uses from all 
three Adobe Programs in this course (Photoshop, Illustrator, InDesign). The page reads 
the phrase, “Stay at Quinnipiac University Kids” because for this particular assign-
ment, I thought the quote fit well and I believe it’s true and unique to me personally. 
The poster’s background is royal blue and gold because those are the primary colors 
of Quinnipiac University, specifically in the institution’s logos. The words ‘Stay’, ‘at’, 
‘University’, and ‘kids’ include a white, 3-point stroke so that the light and dark back-
ground colors wouldn’t contradict or conflict with the text (to make it readable). Now, 
in terms of the usage of all three programs, Illustrator came into play when I inserted 
the provided top, circular logo into that program, and used its color panel to find a 
swatch I personally liked. On the other hand, Photoshop was involved when I placed 
the bottom curvy, bow-like logo into that program, and used the eraser tool to omit 
the unnecessary negative space around it. Then, I used Photoshop’s brush tool to paint 
the logo mixed shades of orange and yellow. Lastly, I combined all these separate 
images and text into InDesign to arrange and organize them as one collective poster 
design.
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Single-page Turtle

In this InDesign composition, I used the provided images and text about turtles, and combined 
them into a one letter-sized page layout. The images are various green turtles, and I used the 
text wrap feature to allow the images to fit well with the negative space. The text was placed in a 
three-column style to allow for all the pictures to fit well and so that the text could be read clearly. 
I altered the headline’s font to Cochin and bolded it, and the headline and sub headline’s font to 
Cooper std. In addition, the sub headline was italicized in black for visual clarity.  The very begin-
ning of the text is a brief introduction to the content, so that was italicized. A large capital letter 
‘A’ was used in the first word ‘Although’ of the text body. As far as the background ocean photo, I 
used the transparency effect so that the text could still be read, and to create a fading effect in the 
water. Lastly, I used the line segment tool to create two different line designs; including the dia-
mond-shaped one under the sub headline, and two parallel ones used in-between the two gutters. Link to personal blog: http://jakezieglerblog.wordpress.com/

About Me

http://jakezieglerblog.wordpress.com/


JZ
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